Quartus Il Introduction Using Verilog Design

This tutorial presents an introduction to the Qua@ﬁd CAD system. It gives a general overview of a typi-
cal CAD flow for designing circuits that are implemented byngsFPGA devices, and shows how this flow is
realized in the Quartus Il software. The design procesduistiated by giving step-by-step instructions for using
the Quartus Il software to implement a very simple circuiaimAltera FPGA device.

The Quartus Il system includes full support for all of the plgp methods of entering a description of the
desired circuit into a CAD system. This tutorial makes usthefVerilog design entry method, in which the user
specifies the desired circuit in the Verilog hardware desicm language. Two other versions of this tutorial are
also available; one uses the VHDL hardware descriptiondagg and the other is based on defining the desired
circuit in the form of a schematic diagram.

The last step in the design process involves configuring ésigded circuit in an actual FPGA device. To
show how this is done, it is assumed that the user has accwsAdtera DE2 Development and Education board
connected to a computer that has Quartus Il software iegtalA reader who does not have access to the DE2
board will still find the tutorial useful to learn how the FP@#ogramming and configuration task is performed.

The screen captures in the tutorial were obtained using tet@s Il version 5.0; if other versions of the
software are used, some of the images may be slightly differe
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Computer Aided Design (CAD) software makes it easy to imgeta desired logic circuit by using a pro-
grammable logic device, such as a field-programmable gedg @FPGA) chip. A typical FPGA CAD flow is
illustrated in Figure 1.
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Figure 1. Typical CAD flow.

The CAD flow involves the following steps:

e Design Entry — the desired circuit is specified either by means of a schierdagram, or by using a
hardware description language, such as Verilog or VHDL

e Synthesis-the entered design is synthesized into a circuit that stasf the logic elements (LES) provided
in the FPGA chip

e Functional Simulation — the synthesized circuit is tested to verify its functiot@irectness; this simulation
does not take into account any timing issues



e Fitting — the CAD Fitter tool determines the placement of the LEs @efiim the netlist into the LEs in
an actual FPGA chip; it also chooses routing wires in the thimake the required connections between
specific LEs

e Timing Analysis — propagation delays along the various paths in the fittedlitiare analyzed to provide
an indication of the expected performance of the circuit

e Timing Simulation — the fitted circuit is tested to verify both its functionarmctness and timing

e Programming and Configuration — the designed circuit is implemented in a physical FPGA tlyijpro-
gramming the configuration switches that configure the LEbkemtablish the required wiring connections

This tutorial introduces the basic features of the Quartssftware. It shows how the software can be used to
design and implement a circuit specified by using the Vettlagdware description language. It makes use of the
graphical user interface to invoke the Quartus Il commabdsng this tutorial, the reader will learn about:

e Creating a project

Design entry using Verilog code

Synthesizing a circuit specified in Verilog code

Fitting a synthesized circuit into an Altera FPGA

Assigning the circuit inputs and outputs to specific pinsttnEPGA

Simulating the designed circuit

Programming and configuring the FPGA chip on Altera’s DE2rdoa

1 Getting Started

Each logic circuit, or subcircuit, being designed with Quail software is called aroject The software works
on one project at a time and keeps all information for thajgmtdn a single directory (folder) in the file system.
To begin a new logic circuit design, the first step is to creatirectory to hold its files. To hold the design files
for this tutorial, we will use a directorintrotutorial. The running example for this tutorial is a simple circuit fo
two-way light control.

Start the Quartus Il software. You should see a display amtd the one in Figure 2. This display consists
of several windows that provide access to all the featur&duzfrtus Il software, which the user selects with the
computer mouse. Most of the commands provided by Quartustilare can be accessed by using a set of menus
that are located below the title bar. For example, in Figuclicking the left mouse button on the menu named
File opens the menu shown in Figure 3. Clicking the left mouseobutin the entrnjExit exits from Quartus Il
software. In general, whenever the mouse is used to selewthong, thdeft button is used. Hence we will not
normally specify which button to press. In the few cases whismecessary to use thigght mouse button, it will
be specified explicitly.
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Figure 2. The main Quartus Il display.
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Figure 3. An example of the File menu.



For some commands it is necessary to access two or more nreseguience. We use the conventidenul
> Menu2 > Item to indicate that to select the desired command the userdffiost click the left mouse button
on Menul, then within this menu click oMenu2, and then withirMenu?2 click on Item. For exampleFile >
Exit uses the mouse to exit from the system. Many commands candieeith by clicking on an icon displayed in
one of the toolbars. To see the command associated with anposition the mouse over the icon and a tooltip
will appear that displays the command name.

1.1 Quartus Il Online Help

Quartus Il software provides comprehensive online docuatiem that answers many of the questions that may
arise when using the software. The documentation is actéss®a the menu in thélelp window. To get some
idea of the extent of documentation provided, it is worthHe/fior the reader to browse through tHelp menu.
For instance, selectingelp > How to Use Help gives an indication of what type of help is provided.

The user can quickly search through the Help topics by setgktelp > Search, which opens a dialog box
into which key words can be entered. Another method, corgemsitive help, is provided for quickly finding
documentation for specific topics. While using most apfilices, pressing th€1 function key on the keyboard
opens a Help display that shows the commands availabledapplication.

2 Starting a New Project

To start working on a new design we first have to define a design project Quartus Il software makes the
designer’s task easy by providing support in the form wizard Create a new project as follows:

1. Selectrile > New Project Wizard to reach the window in Figure 4, which indicates the capighilf this
wizard. You can skip this window in subsequent projects bgcking the boxDon’t show me this intro-
duction again. PressNext to get the window shown in Figure 5.

New Project Wizard: Introduction

The Mew Project “Wizard helps you create a new project and preliminary project settings,
including the following:

#  Project name and directory

#  Mame of the top-level design entity
#  Project files and libraries

#  Target device family and device
# EDA tool settings

*f'ou can change the settings for an existing project and specify additional project-wide
zettings with the Settings command [Assignments menu). You can uge the various
pages of the Settings dialog box to add functionality to the project.

™ Don't show me this introduction again

| Mewt > | | Cancel |

Figure 4. Tasks performed by the wizard.
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Figure 5. Creation of a new project.

2. Set the working directory to bietrotutorial; of course, you can use some other directory name of your
choice if you prefer. The project must have a name, whichusilisthe same as the top-level design entity
that will be included in the project. Chookght as the name for both the project and the top-level entity, as
shown in Figure 5. Presdext. Since we have not yet created the direciatyotutorial, Quartus Il software

displays the pop-up box in Figure 6 asking if it should crehtedesired directory. Clickes, which leads
to the window in Figure 7.

GQuartus 11 [x]

& Directory "D:/Antrotutorial” does not exist, Do you want to create it?

e [ls] |

Figure 6. Quartus Il software can create a new directorytfergroject.



New Project Wizard: Add Files [page 2 of 5] El

Select the design files you want to include in the project. Click Add All to add all design files
in the project directory to the project. Mote: you can alwaps add design files to the project
later.
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Figure 7. The wizard can include user-specified design files.

3. The wizard makes it easy to specify which existing fileali§) should be included in the project. Assuming
that we do not have any existing files, clislext, which leads to the window in Figure 8.

New Project Wizard: Family & Device Settings [p... El

Select the family and device you want to target for compilation.

Family: Cyclone Il j
Target device
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Figure 8. Choose the device family and a specific device.



4. We have to specify the type of device in which the desigimedit will be implemented. Choose Cycloh¥
Il as the target device family. We can let Quartus Il softwegkect a specific device in the family, or we can
choose the device explicitly. We will take the latter apmtoa-rom the list of available devices, choose the
device called EP2C35F672C6 which is the FPGA used on A#®&?2 board. Predsext, which opens the
window in Figure 9.

New Project Wizard: EDA Tool Settings [page 4 of...@]

Specify the other EDA tools - in addition to the Quartus || software - used with the project.

™ EDA design entry /
synthesis toal: | J
-
[~ EDA simulation toal: | J
-
™ EDA timing analysis tool: | J
-

< Back | Mewt > | Finizh | Cancel |

Figure 9. Other EDA tools can be specified.

5. The user can specify any third-party tools that shoulddeslu A commonly used term for CAD software
for electronic circuits i€£DA tools where the acronym stands for Electronic Design Automafidris term
is used in Quartus Il messages that refer to third-partystaghich are the tools developed and marketed
by companies other than Altera. Since we will rely solely ara@us Il tools, we will not choose any other
tools. Presdext.

6. A summary of the chosen settings appears in the screemshdvigure 10. PresBinish, which returns to
the main Quartus Il window, but witlight specified as the new project, in the display title bar, ascateid
in Figure 11.



New Project Wizard: Summary [page 5 of 5]

‘wihen vou click Finish, the project will be created with the following settings:

Project directory:
[: fintrotutorial!

Froject name: light
Top-level design entity: light
Mumber of files added: 1]

Mumber of user libraries added: 0

Device assignments:

Family name: Cyclone ||

Device: EP2C35FET2CE
ED& tools:

Dresign entry/spnthesis: <Mone>

Simulatior: <Mone:

Timing analysiz: <Mone>

< Back | et > I Finizh I Cancel |

Figure 10. Summary of the project settings.
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Figure 11. The Quartus Il display for the created project.




3 Design Entry Using Verilog Code

As a design example, we will use the two-way light contratiiecuit shown in Figure 12. The circuit can be used
to control a single light from either of the two switches,andz,, where a closed switch corresponds to the logic
value 1. The truth table for the circuit is also given in theifig Note that this is just the Exclusive-OR function
of the inputsz; andx,, but we will specify it using the gates shown.

X
- i
0 0 0
A Do i
| 1o |1
D

X

Figure 12. The light controller circuit.

The required circuit is described by the Verilog code in Feggi3. Note that the Verilog module is called
light to match the name given in Figure 5, which was specified wherptbject was created. This code can be
typed into a file by using any text editor that stores ASCllsfiler by using the Quartus Il text editing facilities.
While the file can be given any name, it is a common designesagtjze to use the same name as the name of the
top-level Verilog module. The file name must include the egienv, which indicates a Verilog file. So, we will
use the naméght.v.

module light (x1, x2, f);

input x1, x2;

output f;

assignf=(x1 & ~x2) | (~x1 & x2);
endmodule

Figure 13. Verilog code for the circuit in Figure 12.

3.1 Using the Quartus Il Text Editor

This section shows how to use the Quartus Il Text Editor. Yauskip this section if you prefer to use some other
text editor to create the Verilog source code file, which wimamelight.v.

SelectFile > New to get the window in Figure 14, choo%erilog HDL File, and clickOK. This opens the
Text Editor window. The first step is to specify a name for thestfiat will be created. SeleEile > Save As to
open the pop-up box depicted in Figure 15. In the box lab8kaeke as type chooseVerilog HDL File. In the
box labeledrile name typelight. Put a checkmark in the boxdd file to current project. Click Save, which
puts the file into the directorintrotutorial and leads to the Text Editor window shown in Figure 16. Max#ni
the Text Editor window and enter the Verilog code in Figurerit8 it. Save the file by typin§ile > Save, or by
typing the shortcu€trl-s.

Most of the commands available in the Text Editor are sefflaxatory. Text is entered at thesertion point
which is indicated by a thin vertical line. The insertion piotan be moved either by using the keyboard arrow
keys or by using the mouse. Two features of the Text Editoreapecially convenient for typing Verilog code.
First, the editor can display different types of Verilogtetaents in different colors, which is the default choice.
Second, the editor can automatically indent the text on alimevgo that it matches the previous line. Such options
can be controlled by the settingsTnols > Options > Text Editor.
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New [ x]

Device Design Files | Software Files I Other Files I
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Figure 14. Choose to prepare a Verilog file.

Sawve in: I@\ntrotumrial j - B ok B

b

File name: licih
Save as type: IVeriIDg HDL File *w*wig* wh*verilog) j Cancel |

v Add file to current project

v

el light.v

Figure 15. Name the file.

Figure 16. Text Editor window.
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3.1.1 Using Verilog Templates

The syntax of Verilog code is sometimes difficult for a desigto remember. To help with this issue, the Text
Editor provides a collection oferilog templates The templates provide examples of various types of Verilog
statements, such asr@odule declaration, amalwaysblock, and assignment statements. It is worthwhile to beows
through the templates by selectiBdit > Insert Template > Verilog HDL to become familiar with this resource.

3.2 Adding Design Files to a Project

As we indicated when discussing Figure 7, you can tell Qudttsoftware which design files it should use as part
of the current project. To see the list of files already ineldith thelight project, selecAssignments > Settings,
which leads to the window in Figure 17. As indicated on thé dede of the figure, click on the itefffiles. An
alternative way of making this selection is to cho&seject > Add/Remove Files in Project.

If you used the Quartus Il Text Editor to create the file and&bd the box labeleddd file to current project,
as described in Section 3.1, then tlght.vfile is already a part of the project and will be listed in thedaw in
Figure 17. Otherwise, the file must be added to the projectif ou did not use the Quartus Il Text Editor, then
place a copy of the filight.v, which you created using some other text editor, into theadaryintrotutorial. To
add this file to the project, click on théle name: button in Figure 17 to get the pop-up window in Figure 18.
Select thdight.v file and clickOpen. The selected file is now indicated in the Files window of Fei7. Click
OK to include thdight.vfile in the project. We should mention that in many cases thartQa Il software is able
to automatically find the right files to use for each entityerehced in Verilog code, even if the file has not been
explicitly added to the project. However, for complex patgethat involve many files it is a good design practice
to specifically add the needed files to the project, as destabove.
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Gonero
- UserLibraries Selectthe design files youwantto include in the project. Click Add Allto add all design files in the project

- Device directary to the project
- Tirning Reguirements & Options
E-EDA Tool Settings
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Early Timing Estimate
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Figure 17. Settings window.
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Figure 18. Select the file.

4 Compiling the Designed Circuit

The Verilog code in the fildight.v is processed by several Quartus Il tools that analyze the, gyhthesize the
circuit, and generate an implementation of it for the tajep. These tools are controlled by the application
program called th€ompiler.

Run the Compiler by selectingrocessing > Start Compilation, or by clicking on the toolbar ico ® that
looks like a purple triangle. As the compilation moves tlglowarious stages, its progress is reported in a window
on the left side of the Quartus Il display. Successful (orugrsssful) compilation is indicated in a pop-up box.
Acknowledge it by clickingOK, which leads to the Quartus Il display in Figure 19. In the sage window, at the
bottom of the figure, various messages are displayed. Inafaseors, there will be appropriate messages given.

4 Quartus Il - D:/introtutorial/light - light =1
File Edit “iew Project Assignments Processing Tools  Window  Help
D@ |[&|bBR o o |k |ion @B T2l &8

i’ru]:;?;ct .Névig"atur =] =
E ity

Cyclone [1: EP2C35FE72CE
sbc light [i

BE light.» ] @ Compilation Report - Flow Summary ]

module light (x1, =2, £):
input x1, =Z;

© Compilation Report - Flow Summary

4 Compilation Report Flow Summary

 &B Legal Motice
H S Flow Summary Flow Status Successiul - TueJul 12 16:13:37 2005
i SHEA Flow Settings Guartuz || Version 5.0 Build 168 08/22/2005 5P 1 5J Ful
Full Compilatian | B3R Flow Elapsed Time Revision Nare light
- Analysis & Synthesis| | : S B Flow Log Top-level Entity Hame light
- Fitter v Analysis & Synthesis Famiy Cyclone I
* Assembler o S Fitter Device EP2C35FE7ZCE L
- Timing &nalyzer 3 gu Assombler Timing Models Preliminary:
+ QD Timing Analyzer et iming requirements Yes
i Total logic elements 14332160 <1 %)
Total registers 0 v
$ 2 = >
bl | féIJ Infa: Longest tpd from source pin "'+2"" ta destination pin "'f'" i 5.158 ns l}x ~
L] = féIJ Info: Quartuz || Timing Analyzer was successful O erors, 0 wamings v
kB Vo T 1O PO WO ] e | PRI, Ve o i e N e it
1% ¥
W
0 z = ; z
ﬁ System h Pmcessm_g_ﬂ_ Extra Info }\:__Info)\ Wamln_g_/‘"\_ Critical W arning }\ Enor}
giMassage' 0ol 95 P | gatic _J it
For Help, press F1 [l = | Idle |

Figure 19. Display after a successful compilation.
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When the compilation is finished, a compilation report isduced. A window showing this report is opened
automatically, as seen in Figure 19. The window can be résim@ximized, or closed in the normal way, and it

can be opened at any time either by selecBngcessing > Compilation Report or by clicking on the icor€ .

The report includes a number of sections listed on the ld# sif its window. Figure 19 displays the Compiler
Flow Summary section, which indicates that only one log&rednt and three pins are needed to implement this
tiny circuit on the selected FPGA chip. Another section igvehin Figure 20. Itis reached by selectiAgalysis

& Synthesis > Equations on the left side of the compilation report. Here we see th&legpressions produced
by the Compiler when synthesizing the designed circuit.eDlesthatf is the output derived as

f=x2%x1

where the $ sign is used to represent the Exclusive-OR aperaDbviously, the Compiler recognized that the
logic expression in our design file is equivalent to this esgion.

© Compilation Report - Analysis & Synthesis Equations

@ Corpilation Report
& B Legal Motice RILZ = x2 § x=1; -
SFA Flow Summary
&BR Flow Settings
&R Flow Elapsed Time --xZ is x2
@ Flow Log —-operation wode is input
- &F 3 dnalysis 8 Synthesis X2 = INPUTI();
S Summary
+ &1 Settings
SR Source Files Read ——x1 iz x1
SR Resource Usage Summary ——operation mode is input
&BR Resource Utilization by Entity
+- &1 Cptimization Results ¥1 = INFUT():
= sadEquations
& i) Messages Lt ois £
* @D Fitter ——operation mwode is output
+- 51 Assembler
+-&H(1 Timing Analyzer £ = OUTPUT{A1LZ);
v
< >

Figure 20. Compilation report showing the synthesized tgus.

4.1 Errors

Quartus |l software displays messages produced during itatiop in the Messages window. If the Verilog design
file is correct, one of the messages will state that the catipil was successful and that there are no errors.

If the Compiler does not report zero errors, then there isadtlone mistake in the Verilog code. In this case
a message corresponding to each error found will be displaythe Messages window. Double-clicking on an
error message will highlight the offending statement inWhélog code in the Text Editor window. Similarly, the
Compiler may display some warning messages. Their detailde explored in the same way as in the case of
error messages. The user can obtain more information atspéafic error or warning message by selecting the
message and pressing thg function key.

To see the effect of an error, open the figght.v. Remove the semicolon in tlessignstatement, illustrating a
typographical error that is easily made. Compile the erosalesign file by clicking on th® icon. A pop-up
box will ask if the changes made to thght.v file should be saved; clickes. After trying to compile the circuit,
Quartus Il software will display a pop-up box indicatingttttee compilation was not successful. Acknowledge it
by clicking OK. The compilation report summary, given in Figure 21, nowfirars the failed result. Expand the
Analysis & Synthesis part of the report and then selddessages to have the messages displayed as shown in
Figure 22. Double-click on the first error message. Quaitssftware responds by opening thght.v file and
highlighting the statement which is affected by the errerslaown in Figure 23. Correct the error and recompile
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the design.

© Compilation Report - Flow Summary

@ Compilation Report Flow Summary

& B Legal Notice
S Flow Summary Flow Status Flow Failed - FriJul 15 11:23:39 2005
&8 Flow Settings Quartusz Il Yersion 5.0 Build 168 06/22/2005 5P 1 SJ Full Wersion
@5 Flow Elapsed Time Fievizion Mame light
@ Flow Log Top-level Entity Mame light
+-&H(1 snalysis & Synthesis Family Cyclone |l
Device EP2C35FET2CE
Timing Models Preliminary
Met timing requirements  MAA

Figure 21. Compilation report for the failed design.

© Compilation Report - Analysis & Synthesis Messages

[Z23 compilation Repart Analysis & Synthe:

& B Legal Notice i
SFA Flow Summary Infa: Running Quartus 1| Analyzis & Spnthesis
@5 Flow Settings A2 Info: Command: quartus_map -read_setiings_files=on --write_settings_files=off light -c light
; Errar: Yerilog HOL spntax erar at light.«[B] near test "endmodule”; expecting """, ar """
&R Flow Elapsed Time =
@ Flow Log fé) Info: Found O design units, including O entities, in source file ight.«
. . Ermor: Quartuz || Analysiz & Synthesiz was unsuccessful. 1 eror, 0 warmings

&3 snalysis 8 Synthesis

S Summary

+ &1 Settings
&8 Source Files Read
< e Meszage: 0 aof 10 ¥ | J
Figure 22. Error messages.
e light.v M= = I

module lighti{xl, =z, f):
input x1, x2;
output f:

azsign £ = (x1 & ~x2) | {~xl & =2}

endmodule

Figure 23. Identifying the location of the error.

5 Pin Assignment

During the compilation above, the Quartus Il Compiler wafto choose any pins on the selected FPGA to serve
as inputs and outputs. However, the DE2 board has hardwinegections between the FPGA pins and the other
components on the board. We will use two toggle switchegléaks 1V, and ST, to provide the external inputs,

x1 andx,, to our example circuit. These switches are connected tBRIGRA pins N25 and N26, respectively. We
will connect the outpuy to the green light-emitting diode labeléd” DG, which is hardwired to the FPGA pin
AE22.
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€ Assignment Editor

H g Categary: | Fin j @ Al || " Pin (b Tirning | # Logic Options |
=l + Information: | This cell specifies the pin name to which you want ko make an assignment, - Double-click to create a new assignment.
A Edit: b 4LYS |<<new>> |
Tao Location If0 Bank 1/ Standard General Function Special Function
1 LEnEWEE
< ¥

Figure 24. The Assignment Editor window.

Pin assignments are made by using the Assignment Editact@elsignments > Pins to reach the window
in Figure 24. UndeCategory selectPin. Double-click on the entry <new>> which is highlighted in blue in
the column labeled To. The drop-down menu in Figure 25 willear. Click onz1 as the first pin to be assigned;
this will enterz1 in the displayed table. Follow this by double-clicking o thox to the right of this new1
entry, in the column labeled Location. Now, the drop-dowmma Figure 26 appears. Scroll down and select
PIN_N25. Instead of scrolling down the menu to find the desired pin, gan just type the name of the pin (N25)
in the Location box. Use the same procedure to assign iribiat pin N26 and outpuf to pin AE22, which results
in the image in Figure 27. To save the assignments made, elfiles> Save. You can also simply close the
Assignment Editor window, in which case a pop-up box will #sfou want to save the changes to assignments;
click Yes. Recompile the circuit, so that it will be compiled with therect pin assignments.

Tao

o f
Byl
32

Figure 25. The drop-down menu displays the input and outpotas.

Location |I,|’O Bank 1/ Standard General Function Special Fun
| | Ll LWTTL

PIM_M1 1/ Bank 2 Dedicated Clock. CLK1, LYDSCLEOR, Input A
PIN_NZ 1/ Bank 2 Dedicated Clock. CLKD, LYDSCLEOp, Input

PIN_N9 [OBankz  Row o LYDS31p

PIN_N1G [OBankS  Row o LYDS110p

PIN_NZ0 [OBankS  Row o LYDS124p

PIN_NZ3 [OBankS  Row o LYDS126p, DPCLET/DOSORICO LR,

PIN_MZ: IO Bank 5 Row [jO LYDS5126n
PIN_MNZ5 IO Bank 5 2 Clock. CLK4, LYDSCLKZp, Input
PIMN_MNZ6 1/ Bank 5 Dedicated Clock. CLKS, LYDSCLEZn, Input

PIN_P1 If0 Bank 1 Dedicated Clock. CLK3, LVDSCLE LR, Input

PIN_PZ If0 Bank 1 Dedicated Clock. CLKZ, LVDSCLE1p, Input

PIN_P3 [oBankl  RowIjo LYDS26p, DPCLEL/DOSIL/CO1LE
PIN_P4 [oBankl  RowIjo LYDS26n

PIN_P& [oBankl  RowIjo LYDS22n

PIN_P7 [oBankl  RowIjo LYDS22n

PIN_P9 [OBankz  Row o LYDS31n

PIN_P17 IJO Bank & Row [jO LYDS5130n

PIN_P18 IO Bank 5 Row [jO LYDS5110n

PIN_PZ3 [OBanks  Row o LYDS127p, DPCLKS/DOSIRICO LIRS
PIN_P24 IJO Bank & Row [jO LYDS127n L

Figure 26. The available pins.
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¢ Assignment Editor* E‘@‘E|

&7 (= Cateqgary: | Fin j @ Al || " Pin (b Tirning | # Logic Options |
Information: | This cell specifies the pin name ko which ywou want to make an assignment.,
(@] Edit: | [ |
|T0 Location If0 Bank 1/ Standard | -

At ||t | PIN_N2S 5 LVTTL
z |2 PIN_NZ6 3 LYTTL

T 3 | r PIN_AEZZ 7 LYTTL

g€ |4 LYTTL

Bl LYTTL N
< ¥

G

Figure 27. The complete assignment.

The DE2 board has fixed pin assignments. Having finished osigriethe user will want to use the same
pin assignment for subsequent designs. Going through theedure described above becomes tedious if there
are many pins used in the design. A useful Quartus Il featlwe/sithe user to both export and import the pin
assignments from a special file format, rather than credtiagn manually using the Assignment Editor. A simple
file format that can be used for this purpose isthenma separated value (CS\gymat, which is a common text
file format that contains comma-delimited values. This filefat is often used in conjunction with the Microsoft
Excel spreadsheet program, but the file can also be createaioyusing any plain ASCII text editor. The format
for the file for our simple project is

To, Location
x1, PIN_N25
x2, PIN_N26
f, PIN_AE22

By adding lines to the file, any number of pin assignments eacrbated. Suctsvfiles can be imported into any
design project.

If you created a pin assignment for a particular project, gani export it for use in a different project. To see
how this is done, open again the Assignment Editor to reaelwthdow in Figure 27. Now, seleElle > Export
which leads to the window in Figure 28. Here, the fifght.csvis available for export. Click ofxport. If you
now look in the directoryntrotutorial, you will see that the fildight.csvhas been created.

Export §|

Save in: | ) introtutarial ﬂ £ B
Idb

File name:

Save as type: |Eomma Separated Yalue File [* cav] j Cancel

Figure 28. Exporting the pin assignment.
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You can import a pin assignment by choosisgsignments > Import Assignments. This opens the dia-
logue in Figure 29 to select the file to import. Type the namtheffile, including theesvextension and the full
path to the directory that holds the file, in the File Name bk pres<OK. Of course, you can also browse to find
the desired file.

Import Assignments @

Specify the source and categories of azsignments to import. Click LogicLock Import File Assignments
to zelect LogicLock Import File[z].

Aszsignment source
| L] L |

* File name:

" Use LogicLock Import File Assignments 4

[v Copy existing assignments into light.gsf bak before imparting

| Cancel |

Figure 29. Importing the pin assignment.

For convenience when using large designs, all relevantgsiyaments for the DE2 board are given in the file
calledDE2_pin_assignments.csvthe directoryDE2_tutorials,design_fileswhich is included on the CD-ROM
that accompanies the DE2 board and can also be found on AlIRE2 web pages. This file uses the names found
in the DE2 User Manual If we wanted to make the pin assignments for our exampleuitiby importing this
file, then we would have to use the same names in our Veriloiguéite; namely, SW[0], SW[1]andLEDG|0]
for x1, x2 andf, respectively. Since these signals are specified irDfe2 pin_assignments.cfile as elements
of vectorsSWandLEDG, we must refer to them in the same way in the Verilog design ke example, in the
DE2_pin_assignments.cBle the 18 toggle switches are call&¥V[17]to SW[O]. In Verilog code, they can also
be referred to as a vect&W[17:0}

6 Simulating the Designed Circuit

Before implementing the designed circuit in the FPGA chiptlom DE2 board, it is prudent to simulate it to
ascertain its correctness. Quartus Il software includésalation tool that can be used to simulate the behavior
of a designed circuit. Before the circuit can be simulatet, hecessary to create the desired waveforms, called
test vectorsto represent the input signals. It is also necessary tdfgpelsich outputs, as well as possible internal
points in the circuit, the designer wishes to observe. Thwikitor applies the test vectors to a model of the
implemented circuit and determines the expected respdisavill use the Quartus Il Waveform Editor to draw
the test vectors, as follows:

1. Open the Waveform Editor window by selectifilge > New, which gives the window shown in Figure 30.
Click on theOther Files tab to reach the window displayed in Figure 31. Chodsetor Waveform File
and clickOK.

2. The Waveform Editor window is depicted in Figure 32. Séeeftle under the namleght.vwf, note that this
changes the name in the displayed window. Set the desiradation to run from 0 to 200 ns by selecting
Edit > End Time and entering 200 ns in the dialog box that pops up. Sele&tiagy > Fit in Window
displays the entire simulation range of 0 to 200 ns in the wimdas shown in Figure 33. You may wish to
resize the window to its maximum size.
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New [ ]
Device Design Files | Software Files I Other Files I

Block Diagram/Schematic File
EDIF File

Werilog HOL File

WHOL File

Ok | Cancel |

Figure 30. Need to prepare a new file.

New [ x]

Device Design Filesl Software Filas  Other Files |

AHDL Include File

Block Symbaol File

Chain Description File
Hexadecimal (Intel-Format) File
Memory Initialization File
SignalTap Il File

Tcl Script File

TextFile
Ve

eform File

Ok | Cancel |

Figure 31. Choose to prepare a test-vector file.

R light.wwf =13
Master Time Elar:| 1415 ns ﬂpainter:| 1.0ns Interval | -13.15 ns Stan:‘ End:|
ps 1D.ID ns 20 ID ns |
Mame 1416 ns
o
KU KN i

Figure 32. The Waveform Editor window.
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B light.vwf* [_[o]x]
Master Time Elar:| 1415 ns J_'l Pointer:| 4.87 ns Interval:| 9.28 ns Start| End:|
ps 4D.ID ns BDIDns 120.|D ns 1ED.ID ns 200.0 nsl
Mame 1415 ns
o
< | ol

3. Next, we want to include the input and output nodes of theudito be simulated. Clicledit > Insert
Node or Bus to open the window in Figure 34. It is possible to type the nahe signal (pin) into the
Name box, but it is easier to click on the button labe\extle Finder to open the window in Figure 35. The
Node Finder utility has a filter used to indicate what type ed@s are to be found. Since we are interested
in input and output pins, set the filter Rins: all. Click theList button to find the input and output nodes as

Figure 33. The augmented Waveform Editor window.

indicated on the left side of the figure.

Node Finder

Insert Node or Bus [
MName I oK I
Type: [InPUT | Cancel |
Valuetype: |9-Level =l NodeFinder. |
Radix [Binary =l
Bus wiclth: I1
Startindex: ID
[ Display gray code count as hinary count

Figure 34. The Insert Node or Bus dialogue.

X

Mamed: |i j Filter: |Pins: all j Custamize... | List | Q QK |
Lock in: jJ V' Include subentities | Cancel |
Modes Found: Selected Nodes:

Mame Aszzignments | Tupe ¥ | Mame Aszsighments | Tupe

I f PIN_&E22 Output s 9 [lightl1 PIN_N26 Input

| PIN_MNZE Input B lightlx2 PIN_MNZ5 Input

2 PIN_N25 Input < L lightlf PIN_&E22 Output

< ¥ < < ¥

Figure 35. Selecting nodes to insert into the Waveform Edito
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Click on thex1 signal in the Nodes Found box in Figure 35, and then click:tfsign to add it to the Selected
Nodes box on the right side of the figure. Do the samexfbandf. Click OK to close the Node Finder
window, and then cliclOK in the window of Figure 34. This leaves a fully displayed Wave Editor
window, as shown in Figure 36. If you did not select the noddhé same order as displayed in Figure 36,
it is possible to rearrange them. To move a waveform up or dowime Waveform Editor window, click on
the node name (in the Name column) and release the mousa&biitte waveform is now highlighted to
show the selection. Click again on the waveform and drag dngiown in the Waveform Editor.

B light.vwf* =1 B3
Master Time Bar | 1415 ns J_'l Pointer:| 3585 ns Interval:| 21.7 ns Start | End |

ps |

MName 1415 ns
o

[ 4 %1
S
EI
‘ | K1 | D

Figure 36. The nodes needed for simulation.

4. We will now specify the logic values to be used for the infighalsx1 andx2 during simulation. The logic
values at the outpdtwill be generated automatically by the simulator. To malesaiy to draw the desired
waveforms, the Waveform Editor displays (by default) \aatiguidelines and provides a drawing feature
that snaps on these lines (which can otherwise be invokeddgysingview > Snap to Grid). Observe also
a solid vertical line, which can be moved by pointing to it Bmd dragging it horizontally. This reference
line is used in analyzing the timing of a circuit; move it teetime = 0 position. The waveforms can be

drawn using the Selection Tool, which is activated by seigdhe iconk in the toolbar, or the Waveform
Editing Tool, which is activated by the icc#2 .

To simulate the behavior of a large circuit, it is necessagfiply a sufficient number of input valuations and
observe the expected values of the outputs. In a large tit@inumber of possible input valuations may
be huge, so in practice we choose a relatively small (buesptative) sample of these input valuations.
However, for our tiny circuit we can simulate all four inpw@luations given in Figure 12. We will use four
50-ns time intervals to apply the four test vectors.

We can generate the desired input waveforms as follows.k @licthe waveform name for thel node.
Once a waveform is selected, the editing commands in the MfawxeEditor can be used to draw the desired
waveforms. Commands are available for setting a seleage@lsio 0, 1, unknown (X), high impedance (2),
don’t care (DC), inverting its existing value (INV), or deifig a clock waveform. Each command can be
activated by using thEdit > Value command, or via the toolbar for the Waveform Editor. The Huknu
can also be opened by right-clicking on a waveform name.

Setx1to O in the time interval O to 100 ns, which is probably alreadiby default. Next, setLto 1 in the
time interval 100 to 200 ns. Do this by pressing the mouseeasthrt of the interval and dragging it to its

end, which highlights the selected interval, and choodiegagic value 1 in the toolbar. Make& = 1 from
50 to 100 ns and also from 150 to 200 ns, which correspondsttrath table in Figure 12. This should
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produce the image in Figure 37. Observe that the oufpsitdisplayed as having an unknown value at this
time, which is indicated by a hashed pattern; its value vélbietermined during simulation. Save the file.

% light.vwf*
Master Time Bar: 0ps 1| ¥| Painter: 128.07 nz Interval: 128.07 nz Start: End:
0 pz 4D.ID nz SD.ID nz 12DiD nz 1BDiD nz 200.0 n4
Mame 0ps
i
EI |
I IEEREREEEN EEEEEEEEEN
EI
< ¥

Figure 37. Setting of test values.

6.1 Performing the Simulation

A designed circuit can be simulated in two ways. The simplest is to assume that logic elements and intercon-
nection wires in the FPGA are perfect, thus causing no delgrapagation of signals through the circuit. This
is calledfunctional simulation A more complex alternative is to take all propagation dglayo account, which
leads tatiming simulation Typically, functional simulation is used to verify the fetional correctness of a circuit
as it is being designed. This takes much less time, becaasgrtiulation can be performed simply by using the
logic expressions that define the circuit.

6.1.1 Functional Simulation

To perform the functional simulation, sele&ssignments > Settings to open the Settings window. On the left
side of this window click orSimulator to display the window in Figure 38, chooBanctional as the simulation
mode, and clickOK. The Quartus Il simulator takes the inputs and generatesutpts defined in thight.vwf
file. Before running the functional simulation it is neceys@ create the required netlist, which is done by se-
lecting Processing > Generate Functional Simulation Netlist. A simulation run is started birocessing >

Start Simulation, or by using the ico®.. At the end of the simulation, Quartus Il software indicatesuccessful
completion and displays a Simulation Report illustrateéigure 39. If your report window does not show the
entire simulation time range, click on the report windowetest it and choos¥iew > Fit in Window. Observe
that the outpuy is as specified in the truth table of Figure 12.
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Categony:

General
Files
User Libraries
Device
Timing Reguirements & Options
= EDA Tool Settings
Design Entry/Synthesis
Simulation
Tirning Analysis
Board-Level
Farmal Werification
Physical Synthesis
= Compilation Process Settings
Early Timing Estimate
= Analysis & Synthesis Settings
= Fitter Settings
Physical Synthesis Optimizations
Timing Anakyzer
Design Assistant
SignalTap |l Logic Analyzer
SignalProbe Settings
Simulator
= PowerPlay Power Analyzer Settings
= Software Build Setings
HardCopy Settings

Select options for simulation. Note; the availability of some options depends on the current device family.

Simulation mode:

Simulation input |

Simulation period

" Fun simulation until all vector stimul| are used
ns z

¥ Automatically add pins to simulation output wewveforms

I Check outputs

I™ Setup end hold e vialation defection

¥ Simulation coverage reporting

€ End simulation at

= Glith detecticn

I Owerwrite simulation input file with simulation results

WPCare Transacton Modsl Fle Name: |

Signal activity output for power analysis

™ Generate Signal Activity File

light st J

Bignal Activity il Dptions..

File fame

Cancel

o]

|

Figure 38. Specifying the simulation mode.

Simulation Waveforms

Master Time Bar: 0ps 1| ¥| Painter: 196.84 nz Interval: 196.84 nz Start: End:
0 pz 4D.ID nz SD.ID nz 12DiD nz 1BDiD nz 200.0 n4
Mame 0ps
i
> «1 J
I INEEEEEEEN s EEEEEnEnensnini Sl pnnnnnnnnn
EI IREEREEEEN EEEEEEEEEE
< ¥

Figure 39. The result of functional simulation.

6.1.2 Timing Simulation

Having ascertained that the designed circuit is functigrarrect, we should now perform the timing simulation
to see how it will behave when it is actually implemented ia thosen FPGA device. Selgkssignments >
Settings > Simulator to get to the window in Figure 38, choo$ening as the simulation mode, and cli€XK.

Run the simulator, which should produce the waveforms inufegl0. Observe that there is a delay of about 6
ns in producing a change in the sigrfafrom the time when the input signals; andzs, change their values.
This delay is due to the propagation delays in the logic efgrard the wires in the FPGA device. You may also
notice that a momentary change in the valug pfrom 1 to 0 and back to 1, occurs at about 106-ns point in the
simulation. Thisglitch is also due to the propagation delays in the FPGA device,usecehanges im; andxs
may not arrive at exactly the same time at the logic elemetitgbnerateg.
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Simulation Waveforms

Master Time Bar: 0ps 1| ¥| Painter: B98 pz Interval: B98 pz Start: End:

0 pz 4D.ID nz SD.ID nz 12DiD nz 1BDiD nz 200.0 n4
Mame 0ps
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¥ | b
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Figure 40. The result of timing simulation.

7 Programming and Configuring the FPGA Device

The FPGA device must be programmed and configured to impletmedesigned circuit. The required configura-
tion file is generated by the Quartus Il Compiler's Assembiedule. Altera’s DE2 board allows the configuration
to be done in two different ways, known as JTAG and AS mode® cdmfiguration data is transferred from the
host computer (which runs the Quartus 1l software) to therdbdy means of a cable that connects a USB port
on the host computer to the leftmost USB connector on thedbdar use this connection, it is necessary to have
the USB-Blaster driver installed. If this driver is not ady installed, consult the tutori@etting Started with
Altera’s DE2 Boardfor information about installing the driver. Before usidgetboard, make sure that the USB
cable is properly connected and turn on the power supplychwih the board.

In the JTAG mode, the configuration data is loaded directly ihe FPGA device. The acronym JTAG stands
for Joint Test Action Group. This group defined a simple waytésting digital circuits and loading data into
them, which became an IEEE standard. If the FPGA is configuréldls manner, it will retain its configuration
as long as the power remains turned on. The configurationnrefion is lost when the power is turned off. The
second possibility is to use the Active Serial (AS) mode.hiis tase, a configuration device that includes some
flash memory is used to store the configuration data. Quartaftivare places the configuration data into the
configuration device on the DE2 board. Then, this data isddaato the FPGA upon power-up or reconfiguration.
Thus, the FPGA need not be configured by the Quartus Il softifidine power is turned off and on. The choice
between the two modes is made by the RUN/PROG switch on thelld&2l. The RUN position selects the JTAG
mode, while the PROG position selects the AS mode.

7.1 JTAG Programming

The programming and configuration task is performed asv@loFlip the RUN/PROG switch into the RUN
position. Selecilools > Programmer to reach the window in Figure 41. Here it is necessary to §péoe
programming hardware and the mode that should be used. Hlresdy chosen by default, select JTAG in the
Mode box. Also, if the USB-Blaster is not chosen by defauless theHardware Setup... button and select the
USB-Blaster in the window that pops up, as shown in Figure 42.

i light.cdf
éa Hardware Setup... USE-Blaster [USE-O] Mode: [JTAG | Progress 0%
W Start File ‘ Device ‘ Checksum Usercode E[oongfi[gaLT; Werify Elﬁggk Examine
light. saf EP2C3I5FET2 O02F7EEE FFFFFFFF O O
*E'ﬂ Auto Detect
& Add File...
< ¥

Figure 41. The Programmer window.
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Observe that the configuration filight.sofis listed in the window in Figure 41. If the file is not alreadistéd,
then click Add File and select it. This is a binary file produced by the Compil&ssembler module, which
contains the data needed to configure the FPGA device. Thaggh.sofstands for SRAM Obiject File. Note
also that the device selected is EP2C35F672, which is theAFiR®ice used on the DE2 board. Click on the
Program/Configure check box, as shown in Figure 43.

Hardware Setup

X

Hardware Seftings IJTAG Settings]

Select a programming hardware getup to use when programming devices. This programming
hardware zetup applies only ta the current programmer window.
Currently selected hardware: USB-Blaster [USE-0]
Available hardware items:
Hardware Server | Fart | Add Hardware...
USE-Elaster Local Use-0

Figure 42. The Hardware Setup window.

i light.cdf =13
éa Hardware Setup... USE-Blaster [USE-0] Mode: [JTAG | Progress: 0%

" Frogram/
W Start File Configure
*E'ﬂ Auto Detect
¥ Delete

(2 4dd File...

li= Change File...

Figure 43. The updated Programmer window.

Now, pressStart in the window in Figure 43. An LED on the board will light up winéhe configuration data
has been downloaded successfully. If you see an error expbytQuartus Il software indicating that programming
failed, then check to ensure that the board is properly pegven.

7.2 Active Serial Mode Programming

In this case, the configuration data has to be loaded into dhéguiration device on the DE2 board, which is
identified by the name EPCS16. To specify the required cordtgn device selecAssignments > Device,
which leads to the window in Figure 44. Click on tBevice & Pin Options button to reach the window in
Figure 45. Now, click on th€onfiguration tab to obtain the window in Figure 46. In the Configurationidev
box (which may be set to Auto) choose EPCS16 and ¢lisk Upon returning to the window in Figure 44, click
OK. Recompile the designed circuit.
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Settings - light

Category:

General
Files
User Libraries [Current Project]
Device
Timing Requirements & Options
+- ED& Tool Seftings
|- Compilation Process Settings
nalysiz & Synthesiz Settings
+|- Fitter Settings
i Timing Analyzer
Dresign Assistant
il SignalTap Il Logic Analyzer
il SignalProbe Settings
- Simulator
+- PowerPlay Power &nalyzer Settings
1+ Software Build Settings
HardCopy Settings

Select the family and device you want to target for compilation.

Family: | Cyclone I L] Device & Pin Options..

i~ Target device-
7 At device selected by the Fitter from the "Available devices' list

(' Specific device selected in ‘Svailable devices' list

Available devices: Shiow in ‘Ayvailable devices' list

EP2CBF256C7 [Advanced)
EP2CBF256C8 [Advanced)
EP2CBF 25618 [Advanced)
EP2CB0208C7 (Advanced)
EP2CB0208CE (Advanced)
EP2C8020818 (Advanced)
EP2CAT144CE [Advanced)
EP2CBT144C7 [Advanced)
EP2CAT144C8 [Advanced)
EP2CBT14418 [Advanced)
EP2C20F256CE
EP2C20F256C7
EP2C20F256C3
EP2C20F25618
EP2C20F484C6 =1
EP2C20F484C7

EP2C20F484C3

EP2C20F 45413

EP2C35F484C6

EP2C35F484C7

EP2C35F484C3

|>

Package: Any R
Pir count: Any v

Speed grade: [Any - ]

Core voltage: 1.2

W Show advanced devices

i~ Migration compatibility
0 migration devices selected

Migration Devices. ..

Figure 44. The Device Settings window.

Device & Pin Options

scheme.

Options:

Dwal-Purpoze Ping ] WVoltage ]
General

Specify general device options. These options are not dependent on the configuration

[~ Auto usercode

Error Detection CRC ]
] Unuzed Pins ]

Fin Placement ]

Configuration ] Programming Files

onfiguration after errar
[C1Releaze clears before tri-states

[C1Enable user-supplied start-up clock [CLEUSR]
[C1Enable device-wide rezet [DEY_CLRN]
[C1Enable device-wide output enable [DEY_DE]
[C1Enable IMIT_DOME output

JTAG uzer code [32-bit hexadecimal,  |FFFFFFFF

Drescription:

Diirects the device to restart the configuration process automatically if a data error iz
encountered. If this option is turned off, you must externally direct the device to
restart the configuration process if an ermor ocours.

Reset

=]

Cancel |

Figure 45. The Options window.
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X

Device & Pin Options

Drescription:

Dwal-Purpoze Ping ] WVoltage ] Fin Placement ] Error Detection CRC ]
General Configuration Programming Files ] Unuzed Fins ]
Specify the device configuration scheme and the configuration device.
Configuration scheme: |Active Serial [can use Configuration Device] j
Configuration mode: | J
Configuration device
[v Use configuration device: Auto j
Auto
EPC51

EFCS4

v Generate compressed bitstreams |EPCSE4

the target device.

Specifies the configuration device that you want to uge as the means of configuring

Reset
(] 8 | Cancel |

Figure 46. Specifying the configuration device.

The rest of the procedure is similar to the one describedafimthe JTAG mode. Selebols > Program-
mer to reach the window in Figure 41. In the Mode box selective Serial Programming. If you are changing
the mode from the previously used JTAG mode, the pop-up bdigare 47 will appear, asking if you want to
clear all devices. Clickes. Now, the Programmer window shown in Figure 48 will appeaak®lsure that the
Hardware Setup indicates the USB-Blaster. If the configomdile is not already listed in the window, pre&dd
File. The pop-up box in Figure 49 will appear. Select the lidgat.pofin the directoryintrotutorial and click
Open. As a result, the configuration filght.pofwill be listed in the window. This is a binary file produced by
the Compiler's Assembler module, which contains the dataetétoaded into the EPCS16 configuration device.
The extensionpof stands for Programmer Object File. Upon returning to thegRrmmer window, click on the

Program/Configure check box, as shown in Figure 50.

Quartus 1T %]

A

Yeas

Some devices in current device list cannot be added to selected programming mode Active Serial Programming. Do
you want to clear all devices in current device list and switch to selected mode?

[ils] |

Figure 47. Clear the previously selected devices.
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i light.cdf*

éa Hardware Setup...| | USB-Blaster [USE-0] Mode: | Active Serial Programming | Progress: 0%
File Device ‘Ehecksum Uszercode E[oongfi[gaLT; Werify Elﬁggk ‘ Examine

(2 4dd File...

# 4dd Device. .

<
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Figure 48. The Programmer window with Active Serial Progmaing selected.

Select Programming File X
Look, in: |E} introtutarial ﬂ & E-

ik

File name: |Iight.p0f
Files of type: | POF Files [* pof] =] Cancel

Figure 49. Choose the configuration file.

i light.cdf* _
éa Hardware Setup...| | USB-Blaster [USE-0] Mode: | Active Serial Programming « | Progress: 0%
W Start File Device Checksum Usercode Y Werify Elﬁggk Examine

Configure

B2 light.pof

L.Page_0

¥ Delete

li= Change File...

16

1853

Figure 50. The updated Programmer window.

Flip the RUN/PROG switch on the DE2 board to the PROG positieressStart in the window in Figure
50. An LED on the board will light up when the configurationalaas been downloaded successfully. Also, the
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Progress box in Figure 50 will indicate when the configuraiad programming process is completed, as shown
in Figure 51.

i light.cdf*

;E; Hardware Setup...| | USE-Blaster [USB-0] Mode: | Active Serial Programming « | Progress:

. P / - ]
W Start File Checksum Usercode E[oongfi[gaLTe Werify Examine

B light.pof C79348

“Page_0 O O O O

¥ Delete
li= Change File...

< >

Figure 51. The Programmer window upon completion of prognamg.

8 Testing the Designed Circuit

Having downloaded the configuration data into the FPGA dgwiou can now test the implemented circuit. Flip
the RUN/PROG switch to RUN position. Try all four valuatiooisthe input variables; andx,, by setting the
corresponding states of the switchel’; and.SW,. Verify that the circuit implements the truth table in Figur
12.

If you want to make changes in the designed circuit, firsteltee Programmer window. Then make the
desired changes in the Verilog design file, compile the dirand program the board as explained above.
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